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User's Manual

Thank you very much for purchasing this product.

> To ensure correct and safe usage with a full understanding of this product's performance, please be sure

to read through this manual completely and store it in a safe location.

Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.

The contents of this operation manual and the specifications of this product are subject to change

without notice.

> The operation manual and the product have been prepared and tested as much as possible. If you find
any misprint or error, please inform us.

> Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur
through use of this product, regardless of any failure to perform on the part of this product.

> Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur
with respect to any article made using this product.

>
>

Roland DG Corporation



Please read this agreement before opening the sealed disk package
Opening the sealed disk package implies your acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in the disk package ("Software") under this agreement with the following terms and conditions.

I. Coming into Force
This agreement comes into force when you purchase and open the sealed disk package. The effective date of this
agreement is the date when you open the sealed disk package.

2. Property

Copyright and property of this Software, logo, name, manual and all literature for this Software belong to Roland
and its licenser. The followings are prohibited:

Unauthorized copying the Software or any of its support file, program module or literature.

Reverse engineering, disassembling, decompiling or any other attempt to discover the source code of the Soft-
ware.

3. Bounds of License

Roland does not grant you to sub-license, rent, assign or transfer the right granted under this agreement nor the
Software itself (including the accompanying items) to any third party.

You may not provide use of the Software through time-sharing service and/or network system to any third party
who is not individually licensed to use this Software.

You may use the Software by one person with using a single computer in which the Software is installed.

4. Reproduction

You may make one copy of the Software only for back-up purpose. The property of the copied Software belongs
to Roland.

You may install the Software into the hard disk of a single computer.

5. Cancellation

Roland retains the right to terminate this agreement without notice immediately when any of followings occurs:
When you violate any article of this agreement.

When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability

Roland may change the specifications of this Software or its material without notice.

Roland shall not be liable for any damage that may caused by the use of the Software or by exercise of the right
licensed by this agreement.

7. Governing Law
This agreement is governed by the laws of Japan, and the parties shall submit to the exclusive jurisdiction of the
Japanese Court.
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ATO Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property.

Points which must be observed to prevent such injury or damage are described as follows.

*Please also read the important safety information in the user's manual for the modeling ma-
chine.

About AWARNING and /ACAUTION Notices

Used for instructions intended to alert the user to the risk of death or
AWARNING severe injury should the unit be used improperly.

Used for instructions intended to alert the user to the risk of injury or
material damage should the unit be used improperly.

ACAUTION * Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals
or pets.

About the Symbols

The A\ symbol alerts the user to important instructions or warnings. The specific
meaning of the symbol is determined by the design contained within the triangle. The
symbol at left means "danger of electrocution.”

The © symbol alerts the user to items that must never be carried out (are forbidden).
The specific thing that must not be done is indicated by the design contained within the
circle. The symbol at left means the unit must never be disassembled.

The @ symbol alerts the user to things that must be carried out. The specific thing that
must be done is indicated by the design contained within the circle. The symbol at left
means the power-cord plug must be unplugged from the outlet.

N>




&To Ensure Safe Use

(

/N Incorrect operation may cause injury )

/AWARNING

Be sure to follow the operation proce-
dures described in this manual.

Failure to follow the procedures may cause
sudden operation or the like of the machine,
which may result in unexpected injury.

O

Never allow anyone unfamiliar with
the usage or handling of the machine
to touch the machine.

Touching a dangerous location may cause
sudden operation or the like of the machine,
which may lead to an unexpected accident.

O

Never allow children near the ma-
chine.

The machine includes locations and
components that pose a danger to chil-
dren, and major accident, including in-
jury, blindness, or choking, may occur.

Never touch the tip of the probe.Also,
be sure to attach the probe cover when
the sensor unit is not in use.

The tip of the probe is very sharp, and can
cause injury or blindness.

Do not disassemble, repair, or modify.
Doing so may lead to fire or abnormal op-
eration resulting in injury.

(

/N Important Notes on Scanning )

/A\CAUTION

O

Never attempt to scan any object of
high intrinsic or personal value, or that
would otherwise be difficult to replace
if damaged or broken.

Because scanning involves contact by the
probe, the object scanned may be damaged.
Incorrect settings may also cause the
scanned object to strike areas other than
the probe. Scan-object damage is not cov-
ered by warranty.

When loading an object to scan, make
sure that all sides and the top of the
object are within the scannable area.
A scanned object may strike a component
other than the probe and suffer damage.
Scan-object damage is not covered by war-
ranty.

Be sure to remove the probe cover
when performing scanning.

Otherwise the object scanned may strike
the probe cover and suffer damage. Scan-
object damage is not covered by warranty.



A Pour utiliser en toute sécuriteé

La manipulation ou l'utilisation inadéquates de cet appareil peuvent causer des blessures ou
des dommages matériels. Les précautions a prendre pour prévenir les blessures ou les dommages
sont décrites ci-dessous.

*Lire sans faute les importants renseignements sur la sécurité dans le guide de l'utilisateur de

la machine a modeler.

Avis sur les avertissements

Utilisé pour avertir I'utilisateur d'un risque de décés ou de blessure

&ATTENTION grave en cas de mauvaise utilisation de I'appareil.

Utilisé pour avertir I'utilisateur d'un risque de blessure ou de dommage
matériel en cas de mauvaise utilisation de I'appareil.

&PRUDENCE * Par dommage matériel, il est entendu dommage ou tout autre effet
indésirable sur la maison, tous les meubles et méme les animaux
domestiques.

A propos des symboles

avertissements. Le sens précis du symbole est déterminé par le dessin a l'intérieur du

2 Le symbole A\ attire I'attention de 'utilisateur sur les instructions importantes ou les
triangle. Le symbole a gauche signifie "danger d'électrocution".

chose spécifique a ne pas faire est indiquée par le dessin a l'intérieur du cercle. Le

® Le symbole © avertit I'utilisateur de ce qu'il ne doit pas faire, ce qui est interdit. La
symbole a gauche signifie que I'appareil ne doit jamais étre démonté.

indiquée par le dessin a l'intérieur du cercle. Le symbole a gauche signifie que le fil

% Le symbole @ prévient I'utilisateur sur ce qu'il doit faire. La chose spécifique a faire est
électrique doit étre débranché de la prise.




&Pour utiliser en toute sécurité

(

/\ L'utilisation incorrecte peut causer des blessures )

/N\ATTENTION

S'assurer de suivre les procédures
d'utilisation décrites dans ce manuel.
Si les procédures indiquées ne sont pas
suivies, le fonctionnement de I'appareil peut
étre déclenché soudainement, ce qui risque
de causer des blessures.

O

Ne jamais toucher I'extrémité de la
sonde. S'assurer de fixer le couvert de
la sonde lorsque le capteur n'est pas
utilisé.

L'extrémité de la sonde est trés acérée et
peut causer des blessures ou la cécité.

O

Ne jamais permettre a quiconque de
toucher I'appareil s'il ou si elle n'en
connaco pas le fonctionnement ou la
manutention.

Toucher I'appareil a certains points
dangereux peut en déclencher le
fonctionnement, ce qui risque de causer un
accident imprévu.

O

Ne jamais laisser d'enfants s'approcher
de I'appareil.

Des éléments et des surfaces de I'appareil
présentent des risques pour les enfants. Il
pourrait se produire un accident grave qui
causerait des blessures, ou créerait un ris-
que de cécité ou de suffocation.

®

Ne pas démonter, réparer ni modifier.
Démonter, réparer ou modifier I'appareil ris-
que de provoquer un incendie ou de causer
un fonctionnement anormal entrainant des
blessures.

(

/N Remarque importante sur la numérisation (scanning) )

/A\PRUDENCE

O

Ne jamais tenter de numériser un
objet de grande valeur monétaire ou
sentimentale, ou un objet qui serait
difficile a remplacer s'il était
endommagé ou brisé.

Les objets numérisés risquent d'étre
endommagés parce que la numérisation
exige un contact entre la sonde et I'objet.
En outre, si les réglages sont erronés, I'objet
numérisé peut frapper des points autres que
la sonde. La garantie ne couvre pas les objets
numeérisés.

Pendant le chargement d'un objet a
numériser, s'assurer que tous les cotés
et la partie supérieure de I'objet sont
al'intérieur de la surface numérisable.
Un objet numérisé peut frapper une
composante autre que la sonde et étre
endommagé. La garantie ne couvre pas les
objets numérisés.

S'assurer de retirer le couvert de la
sonde pour faire la numérisation.
Sinon, I'objet numérisé peut frapper une
composante autre que la sonde et étre
endommagé. La garantie ne couvre pas les
objets numérisés.



Important Notes on Handling and Use

This unit is a precision device.To ensure the full performance of this unit, be sure to observe the
following important points. Failure to observe these may not only result in loss of performance,
but may also cause malfunction or breakdown.

This Unit Is a Precision Device

> Never drop or subject to impact.
> Never twist or wrench the probe by hand.
> When not using the sensor unit, attach the probe cover and store in a safe place.

Items That may Not Be Copied

Unauthorized reproduction of a copyrighted item for any purpose other than personal use may be a
violation of copyright.

Roland DG Corp. will not be responsible for any violation of third-party copyright by any article made
through use of this product.
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PreEaring the Sensor Unit



-1 3D Scanning Sensor Unit

Supported Models

> Roland DG MDX-40
> Techsoft TS-30

Unit Features

This is an optional unit that enables you to use any of the preceding compatible models of modeling
machines as a 3D scanner. Replacing the spindle unit with the sensor unit adds contacting 3D-scanner
functionality. Dedicated programs for 3D scanning and for editing 3D data are included.

Checking the Included Items

Sensor unit Cap screws (black) Hexagonal wrench (3 mm)*

Roland Software Package

Clay CD-ROM User's Manual (this manual)

* A 2.5-mm hexagonal wrench is included with the modeling machine.



I-1 3D Scanning Sensor Unit

Part Names and Functions

Probe cover

This cover protects the probe.
When not using the sensor unit,
be sure to attach the probe
cover.

Probe
This touches the scan object
and senses its shape.

This is the connector for con-
nection to the modeling ma-
chine.



-2 Installing the Sensor Unit

Installing the Sensor Unit

/ACAUTION Before you carry out this operation, switch off the power to the model-
ing machine.
Failing to do so may result in sudden movement of the machine, causing the hands
or fingers to become caught and resulting in injury.

/ACAUTION Do not touch the spindle motor immediately or cutter after a cutting
operation has ended.
Doing so may result in burns.

/ACAUTION Perform installation and removal of the sensor unit while the cover is
attached.
Otherwise the probe may stab the hand or fingers and cause injury.

Before you install the sensor unit, complete the setup operations for the modeling machine. For information
on how to perform setup, refer to the documentation included with the modeling machine.

Procedure
(1) o) | , 0 @ Switch off the power to the modeling ma-
= = o 5 chine and unplug its power cord. If a tool is
5 installed, then remove it.

/ @ Remove the belt.
N &~ 0

@ Remove the cap screw shown in the figure.
@ Remove the spindle unit.

Hexagonal wrench
(3 mm)

Install the sensor unit, using black cap screws.

Hexagonal wrench
(3 mm)

10



1-2 Installing the Sensor Unit

@ Slightly loosen the cap screw shown in
the figure.

@ Turn the connector cover to open it.

® Retighten the cap screw.

P .
®
Hexagonal ;/

wrench (2.5 mm)

(5] Insert the cable for the sensor unit into the
connector.
(6 Detach the probe cover.

ACAUTION

Be sure to remove the probe cover when
performing scanning.

Otherwise the object scanned may strike the
probe cover and suffer damage. Scan-object dam-
age is not covered by warranty.

L

Carefully store the removed spindle unit, belt, cap screw, and probe cover so that they do not become
misplaced.

To Reinstall the Spindle Unit

> Switch off the power to the modeling machine, then carry out installation by following the foregoing
procedure in reverse.

>The belt has an inner side and an outer side. Be sure the two sides are oriented correctly.

> After attaching the belt, turn the pulley by hand several times to acclimatize the belt.

The white mark indicates the outer side.

11



-3 Preparing the Programs

System Requirements for the Programs

Operating system: Windows 98 SE (Second Edition)/Me/2000/XP

CPU: Pentium 4 processor or better recommended

Memory: 512 MB or more recommended

Free hard-disk space required Dr. PICZA3: 20 MB or more, 3D Editor: 10 MB or more

for installation:

Display: 800 x 600 resolution and 16 bit colors (High Color) or more
recommended.

OpenGL-compatible accelerator board recommended.

>The Windows-based driver for the modeling machine must already be installed and the computer and
modeling machine must be connected by a USB cable.

>Memory requirement are affected by scanning conditions and the like. Larger scanning areas and finer
scanning pitches require increasingly more memory. We recommend installing enough memory to match
your usage conditions.

System Requirements for USB Connection

Making a USB connection with Windows requires use of a computer that meets all of the following system
requirements. Please note that other configurations cannot be supported.

Operating system: Windows 98 SE/Me/2000/XP
Computer: 1) Computers preinstalled with Windows 98 SE/Me/2000/XP at the time of
purchase (This includes such computers later upgraded to Windows Me/
2000/XP.)
2) Computers on which USB operation is assured by the manufacturer of com-
puters

>The ability to make a USB connection depends on the specifications of the computer. To determine
whether the computer you're using is capable of correct USB operation, check with the manufacturer of
the computer.

> Use a shielded USB cable having a length of 3 meters or less. Do not use a USB hub or the like.

Step |:Installing and Setting Up the Programs

Programs to Install and Set Up
>Dr. PICZA3: This program enables you to perform 3D scanning.
>3D Editor: This program enables you to edit scanned 3D data.

Procedure

Install the Windows-based driver for the mod-
eling machine and make the connection using a
USB cable.

For more information, refer to the documentation
included with the modeling machine. If the con-
nection is already made, go on to procedure 2
below.

12



1-3 Preparing the Programs

(2] Roland Software Package

==Roland Roland Software Package

for PICZA, MODELA, CAMM-2, CAMM-3

@ -Dr:
M- DriPICZAS Step

Click the drop-down arrow for [Click

] 0
ElsnEdiEay here ] and choose the model name.

Sten 2
Click [Install]

4
To view the description of a program, i
click the [i] button

VWhen a checkbox is not selected, setup

is not performed for the corresponding
program

i Ga to Roland DG Corporation Homepage I

0 Welcome &‘

Welcame ta the Dr.PICZA3 Setup progiam. This
program wil inetall Dt FICZA3 on your compuler.

[t s strarigly recommendsd that pou et all Windows programs
befare running this Setup program.

Click Cancel to quit Setup and then close any programs you
have rurring, Click Next to continue with the Setup program

WARNING: This program s protested by copyright law and
international reaties.

Unauthorized reproduction or distibution of this program, or any
partian o it may resultin severe civi and criminal penakies, and
will be:prosecuted to the marimum extent possible under law

Mext> ) Cancel

Complete.

@ If you're using Windows 2000/XP, log on to

an "Administrators" account.

@ Insert the Roland Software Package CD-ROM

into the computer's CD-ROM drive.

After a short wait, the setup menu appears.

@ Select [ZSC-1].
@ Click [Install].

Click [Next], then follow the on-screen instruc-
tions to complete setup and installation.

When this window appears, click [Close].
This completes setup and installation of all the
programs. Go on to Step 2.

Important Note about the Version of the CD-ROM
For the Roland Software Package CD-ROM (RSP-009), use either the version included with this unit, or
a newer version.Versions of the CD-ROM earlier than 2.6D are not compatible with this unit.

13



1-3 Preparing the Programs

14

Step 2: Making the Settings for Dr. PICZA3

Procedure

o

9 ¥ Untitled - Dr.PICZA3

GLN Edit view Select Help

Hew Chrlei
Open... i
save s
Save fs..

Export »

can,
CHrl4p
vien

et preferences

o
)

v Show data during scanning

™ Simple display

Cancel
W Always fit to screen

[™ Use tiangular planes
I Replace rescanned partion [Pl only)
[™ Disablz data not o pitch

[” Beep when scanning ends

Besp ,7 J Q
Unda Count: 5 @
Bart: [Foland MO 40 ) =]
Urit: [ren =]

This completes the preparations for the program.

Checking the Connection

Turn on the power to the modeling machine.

@ From the [Start] menu, click [All Programs] -
[Roland Dr. PICZA3] - [Dr.PICZA3].
@ Go to the [File] menu and click [Preferences].

@ For [Port], select the model name of the mod-
eling machine you're using.

@ Click [OK].

® Go to the [File] menu and click [Exit] to quit
Dr. PICZA3.

In Dr. PICZA3, go to the [Help] menu and display [About]. If the firmware version and model name are

displayed, the connection is correct.



Chapter 2
Use and Operation As a

3D Scanner
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2-1 Operation As a 3D Scanner

Operation As a 3D Scanner
Startup

Close the front cover.

Switch on the main power switch.

|
The POWER light comes on.
o

(3] Press the Sub power button.
The machine starts up, and initialization is per-
p= formed. After initialization ends, the SCANNING
light and the VIEW light comes on and the ma-

chine is paused.

(4] Press the VIEW button.
The view state is canceled, and the machine fin-
5 ishes preparations for performing scanning.

To Start Scanning

> Close the front cover and make the VIEW light go dark.

> During scanning, never open the front cover.

>You can pause scanning by pressing the VIEW button. Pressing the VIEW button a second time resumes
operation.

>You can open the front cover while operation is paused.

Operation During the Scanning Mode

>The SCANNING light comes on when the machine is in the scanning mode.

>The machine automatically changes to the scanning mode when the sensor unit is installed and to the
modeling mode when the spindle unit is installed.

> The operation of other buttons and controls is identical both in the scanning mode and in the modeling
mode. Refer to the documentation included with the modeling machine.

>When in the scanning mode, the "operation-panel screen" cannot be used.

16



2-1 Operation As a 3D Scanner

Objects That Can and Cannot Be Scanned

Objects Unsuitable for Scanning
Objects that change shape when touched by the probe cannot be scanned.

> For example, objects such as items made of soft rubber or fuzzy stuffed animals cannot be scanned.
> Depending on the configuration of the object, error equal to about the radius of the probe (0.5 mm) may

occur.

ACAUTION Never attempt to scan any object of high intrinsic or personal value, or
that would otherwise be difficult to replace if damaged or broken.
Because scanning involves contact by the probe, the object scanned may be dam-
aged. Incorrect settings may also cause the scanned object to strike areas other
than the probe. Scan-object damage is not covered by warranty.

Scannable Area
The figure shows the scannable area.

60 mm (2-5/16 in.)

324 mm (I-1/4in.)
This area cannot be
scanned. \

Table

92.4 mm (3-5/8 in)

The size that can actually be scanned depends on the amount of memory in the computer. For more
information, refer to page 20, "Amount of Computer Memory Required."

17



2-1 Operation As a 3D Scanner
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Mounting the Object to Scan

Mounting the Object to Scan
>Secure in place with the surface to scan facing up.
>Secure firmly to keep from moving during scanning.

/ACAUTION When loading an object to scan, make sure that all sides and the top of
the object are within the scannable area.
A scanned object may strike a component other than the probe and suffer dam-
age. Scan-object damage is not covered by warranty.

Various Methods for Securing in Place
> Double-sided adhesive tape can be useful for flat-
bottomed object.

=

>When the bottom is uneven, it may be possible
to secure the object by pressing it into a piece of
clay.

To Scan a Small or Thin Object

If the portion you want to scan isn't positioned inside the scanning area, place a block or the like under-
neath it to elevate it.

However, be sure to keep its height at 92.4 mm (3-5/8 in.) or less from the table surface.

Maximum scanning area

This portion can

60
be scanned. ™~ (2-;?:2 in.)

92.4 mm
(3-5/8in.)




2-2 Using the Included Programs

User's Manuals for the Programs

Description of Basic Operation
1 See page 21, "Chapter 3 Basic Scanning Operation”

Detailed Description
You can find detailed explanations of the programs in the online help (electronic-format manuals).

Er.PICZABHelp — EEX Dr.PICZA3
o ot P | From the [Start] menu, click [All Programs] - [Ro-

Contents | ldex

. land Dr. PICZA3] - [Dr. PICZA3 Help].

% (2] Operalion Procedures

= (0] Hints and Tips

= (3 Commands

= (3 1FouT) ok
5] Mems that map nt be copied
(2] Glossary of Tems

blem.

bt/ rolandds, com/
Copyright (C) 2002-2004 Roland DG Coropration

3D Editor
G A From the [Start] menu, click [All Programs] - [Ro-

land 3D Editor] - [3D Editor Help].

=@
(] Basic Operations for Dbjects
aH s

/

= O
(21 1FYou Think There's a Froblem,
(=] Glossary of Tems

hitpforww rolanddg, com/
Copyright (C) 2002-2004 Roland DG Coropration

ot of
Ui Sase e oo conatziee

*Bcinosh nd. QuidDran e regisard rademeks of Agple Comprter, b i the USA
Jrepm—"

B
Comperation it Thitd St &

The Machine's Scanning Mode

This machine has only a single scanning mode. It does not support such scanning methods as rotary, plane,
line, or point scanning.

Data exported using the "Polylines" command is not supported.



2-2 Using the Included Programs

20

Amount of Computer Memory Required

Important Note about Required Memory

The amount of memory required increases proportionally as the dimensions of the scanning area grow
larger or as the scanning pitch is made finer. Insufficient memory can slow down the operation of the
computer, and even make it appear to freeze.

Estimating the Memory Requirements
Use the following information as a guide to estimate the amount of memory that Dr. PICZA3 requires.
(These figures do not include memory required by the operating system itself.)

Scanning area (width x depth) Scanning pitch Required memory
100 x 100 mm 0.05 x 0.05 mm Approx. 2 GB

100 x 100 mm 0.1 x0.1 mm Approx. 500 MB
100 x 100 mm 0.5 x 0.5 mm Approx. 20 MB




Chapter 3
Basic Scanning Opera-

tion

21



3-1 Learning the Basics of Scanning

Step |: Setting the Scanning Conditions

Let's start actually scanning something.
You mount the object to be scanned, start the 3D scanner, then use the 3D-scanning program to begin
scanning.

Procedure

@ Start Dr. PICZA3 and display the [Settings for Scanning] dialog box.

@ From the [Start] menu, click [All Pro-
grams] - [Roland Dr. PICZA3] - [Dr.
PICZA3].

@ Click [Scan].

File Edit View Select Help

DBH|~O“\%A’.E.1

I3 Uniitled

@ Make the settings for the area to scan (width and depth).

Settings for Scanning || Type in the lower-left and upper-right
locations of the scanning area.

[~ Scan Area

" Automatic Input
 Manual Add

Delete

&) e

ﬂ . B
DDDD jmh
@‘J et

Scan [itch 0|y o
)| ) &
% [ 039 :I'"Ch | Fine
N | pratt H
v || élinch 1376 :-Imh ------

—>Clicking this returns to the original view.

>This enlarges (zooms) the displayed view. Click this, then drag to enclose
the area you want to enlarge.

> Click this to set or verify the scanning area.

Scan !|tatus

>The orange quadrilateral indicates the area to scan (width and depth).

> Double-clicking a red square moves the probe to that location. You use this
to verify the scanning area.

>You can make the settings for the scanning area by dragging the red squares.

It's a good idea to reduce the area to the smallest size necessary. Making the area larger than
necessary increases the scanning time and uses up excess memory.

22



3-1 Learning the Basics of Scanning

@ Make the settings for the area to scan (height direction).

] @ Enter the lower limit of the scanning

Settings for Scanning
area (the distance of the location

~Scan Area
® i) from the table surface).
e a4 @ Click this check box to select it.
okt | ® Find the highest location on the scan
o e objec't.Then drag this marker to that
location.

E ....... 2000 e @ Click this button.
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>The probe moves and touches the highest location of the scan object. (The area above this is not scanned.)
> |f the location touched is not the highest, then redo ® and @. If it is difficult to guide the probe to the
location you want, it may be useful to place a thick piece of paper or the like on top of the scan object,

then make the probe touch the surface of the paper.
> Omitting this setting causes the entire scannable area to be scanned from top to bottom.

It's a good idea to reduce the area to the smallest size necessary. Making the area larger than necessary
increases the scanning time and uses up excess memory.

@ Set the scanning pitch, then start scanning.

Setiings for Scanning |E”z| @ Enter the Scanning pItCh.
@ Click [Scan].
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" Automatic Input

@ Manual Add
Delete
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Be careful not to make the scanning pitch too small. Smaller settings for the scanning pitch permit
scanning with correspondingly greater detail, but also use up correspondingly larger amounts of memory.



3-1 Learning the Basics of Scanning

Step 2: Checking the Scanning Results

You can preview the results while dragging the object to change its orientation and positioning.

> These change how the object moves when
dragged (rotation, sliding, or zoom).

2 Untitled - Dr.PICZA3 DEx

File Edit Miew Select Help
L= Oy a2 8 A (S
HAR WD g il e

>These change the view.

Vi
//7%% R
W

S
\ \w}“:&‘\

e —— > The three-dimensional item that has been
I e scanned is called the "object."

Step 3: Saving and Exporting Data

If the results are acceptable, then save the data. You can also save (export) data converted to a format that
other programs can import.

Save
Go to the [File] menu and click [Save As].

> Data saved using this method can be opened in Dr. PICZA3 and 3D Editor.
>Once you have saved this data, you can export it in a variety of different formats.

Export
Go to the [File] menu and click [Export].

>3D Editor also has an export feature. It lets you export data in a wider variety of formats than Dr.
PICZA3.
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4-1 What to Do If...

The machine doesn't start

TheVIEW light is flashing.

The sub power button was pressed while the front
cover was open, or the front cover was opened just
after the sub power button was pressed. Close the front
cover and switch the power off. Keep the front cover
closed until startup finishes.

The SCANNING light flashes every 0.5 sec-
ond.

The front cover was opened before startup finished.
Close the front cover and switch the power off. Keep
the front cover closed until startup finishes.

The SCANNING light flashes every 0.1 sec-
ond.

Something touched the sensor during initial opera-
tion immediately after switching on the power, or a
hardware error occurred.

If there is an obstruction, then switch off the power,
remove the obstruction, and switch the power back
on. If there was a hardware error, then switch the
power off and back on and repeat the same opera-
tion. If the same error display occurs, consult your
authorized Roland dealer or service center.

Scanning is impossible

The MODELING light is on.

The sensor unit is not connected. Switch off the power
and check again to make sure the sensor unit is in-
stalled.

The computer displays the message "Cannot
communicate with present scanner."

The setting for the communication port in [Preferences]
for Dr. PICZA3 is incorrect. Refer to page 14, "Step 2:
Making the Settings for Dr. PICZA3," and check the
setting.

Alternatively, no Windows-based driver for the mod-
eling machine is installed. Refer to the documenta-
tion for the modeling machine and install the driver.
Installing and setting up only Dr. PICZA3 does not
enable operation.

Alternatively, try switching off the power and restart-
ing the computer. Also, try changing the USB cable.
Use a USB cable less than 3 meters long, and don't
use a USB hub.

TheVIEW light is on.
Operation is paused. Press the VIEW button to release
the paused state.

TheVIEW light is flashing.
The front cover is open. Close the front cover and redo
the operation.

The SCANNING and VIEW lights are flash-
ing.

The front cover was opened while scanning was in
progress. Operation cannot be continued. Switch the
power off, and redo the operation. To open the front
cover while scanning is in progress, first press the VIEW
button to pause operation.

Other Symptoms

Scanning ended, but the computer then
stopped.

Go to Dr. PICZA3's [Settings for Scanning] dialog box
and increase the scanning pitch. Alternatively, con-
sider installing more memory. When scanning exceeds
the amount of free memory on the computer, the op-
eration of the computer may become very slow.



4-2 Specifications

Scanning-mode Specifications

These are the main specifications of the MDX-40 or TS-30 when the ZSC-1 is installed.

MDX-40/TS-30 (ZSC-1 installed)

Maximum scanning area

305 (X) x 305 (Y) x 60 (Z) mm (12 (X) x 12 (Y) x 2-5/16 (Z) in.)

Distance from probe tip to table

Maximum 92.4 mm (3-5/8 in)

Table load capacity

Maximum 4 kg (8.8 Ib)

Sensor

Type: Roland Active Piezo Sensor (RAPS)
Effective probe length: 60 mm (2-5/16 in.)
Tip bulb radius: 0.08 mm (0.00315 in.)

Scanning method

Contacting, mesh-point height-sensing

Operating speed

X/Y axes: 15 to 30 mm/sec. (0.6 to 1.1 in./sec.)
Z axis: 1 to 30 mm/sec. (0.04 to 1.1 in./sec.)
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